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Demography 2016: Wales summary

The publication Demography 2016 consists of:

- Wales summary document and key messages

- Seven health board summary documents

- Four interactive data files showing the main indicators and key messages
- Three map interactive files

- Infographics of selected key messages

- Technical guides describing the indicators, data sources and caveats

These resources are available at
https://phw.nhs.wales/services-and-teams/observatory/data-and-analysis/demography-

2016/
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How to copy charts and maps into other documents

The standard {Cut}, {Copy} and {Paste} options can be used in Microsoft Word to export tables, charts and maps
to other documents. Images can also be resized as required.

Copying and pasting charts and maps (Figure 1)

1. Select the image you want to copy by left clicking on it once so that the surrounding points are displayed.

2. Either on the ‘Home’ tab or through the right click menu select either *Cut’ or *Copy’.

3. In the document where you want to insert the image, select ‘Paste’ either through the *Home' tab or the right-

click menu.
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Resizing images (Figure 2)

1. To adjust the size, left-click the image once so that the surrounding points are displayed.

2. You can either adjust the length and width manually through the ‘Format’ tab or use the points to resize the
image by clicking and dragging.

3. When resizing an image it is best to use the corner points dragging method, as this will retain the proportions
of the original image. Re-sizing just horizontally or vertically leads to distortion of the perspective and a
reduction in image quality.
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Introduction

This Wales summary document provides national level information on the indicators contained
in the publication Demography 2016. 1t includes selected charts, tables and small area maps
for Wales and is designed to complement the health board summary documents.

The publication Demography 2016 consists of:

- A Wales summary document and key messages

- Seven health board summary documents

- Four interactive data files showing the main indicators and key messages
- Three map interactive files

- Infographics of selected key messages

- Technical guides describing the indicators, data sources and caveats

These resources are available at https://phw.nhs.wales/services-and-
teams/observatory/data-and-analysis/demography-2016/

Note

It has recently come to light that the population aged 85+ has been underestimated in
some areas by the Office for National Statistics population estimates. In most parts of
Wales the impact of this issue will be small. Further details are available from the
Demography 2016 webpage
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Population estimates

Population estimates are produced annually by the Office for National Statistics. The
estimates are based on the most recent Census (2011) from which births are added, deaths
are subtracted and an estimate is made of net migration.

Key messages

e Over the last 10 years (2005 to 2014), the population of Wales has increased by
over 4% from around 2.97 million to 3.09 million (5.1% and 3.2% increase for
males and females, respectively)

e In 2014, an estimated 49% of the population were male and 51% female in Wales

e The largest increase (10.4%) in population was seen in Cardiff which increased from
around 320,000 in 2005 to 350,000 in 2014

e Ceredigion saw the only decrease (-0.1%) in population from 2005 to 2014

e In 2014, 1 in 5 Welsh residents were aged over 65 years (20%), 6 in every 10
(62%) were of working age (16 to 64 years) and nearly 1 in 5 (18%) were aged
under 16

e The population aged under 16 in Wales has decreased by over 2% between 2005
and 2014, from around 568,000 to 555,000

e The population in Wales aged 85+ has increased by over a quarter (27%) between
2005 and 2014, from an estimated 62,000 to 79,000
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2.2 Population trends

Population estimates, count, persons, Wales, 2005-2014

Produced by Public Health Wales Observatory, using MYE (ONS)
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2.3 Population trends by age

Population estimates by age group, percentage, persons, Wales, 2005-2014

Produced by Public Health Wales Observatory, using MYE (ONS)
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2.4 Population pyramid 2005 and 2014 comparison

Percentage of population by age and sex, Wales, 2005 and 2014

Produced by Public Health Wales Observatory, using MYE (ONS)
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2.5 Population estimates by Lower Super Output Area

Under 16

Estimated population aged under 16, Wales, 2014
LSOA, percentage

Bl 282to 35.0 [23]
B 21.5to0 <28.2 [290]
[] 14.8to <21.5 [1245]
[] 8.1 to<14.8 [322]
[] 1.4 to<8.1 [29]

|:| Local authority boundary

Produced by Public Health Wales Observatory, using MYE (ONS)
© Crown Copyright and database right 2016, Ordnance Survey 100044810
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Estimated population aged 16 - 64 years, Wales, 2014
LSOA, percentage

85.7to 96.6 [29]
74.7 to <85.7 [33]
63.8 to <74.7 [483]
52.8 to <63.8 [1298]
41.8 to <52.8 [66]

OO NN

]

Local authority boundary

Produced by Public Health Wales Observatory, using MYE (ONS)
© Crown Copyright and database right 2016, Ordnance Survey 100044810
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65 - 84 years

Estimated population aged 65 - 84 years, Wales, 2014
LSOA, percentage

B 355t0 44.1 [6]
B 26.9to <35.5 [103]
[ 18.3to <26.9 [724]
[] 9.7 to<18.3 [912]
[] 1.0 to<9.7 [164]

P
|:| Local authority boundary

Produced by Public Health Wales Observatory, using MYE (ONS)
© Crown Copyright and database right 2016, Ordnance Survey 100044810
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85+ years

Estimated population aged 85+, Wales, 2014
LSOA, percentage

B s8.5to0 10.6 [10]
B 6.4to0<8.5 [37]
[ 4.3to<6.4 [176]
[] 2.2to <4.3 [825]
[] 0.1to<2.2 [861]

P
|:| Local authority boundary

Produced by Public Health Wales Observatory, using MYE (ONS)
© Crown Copyright and database right 2016, Ordnance Survey 100044810
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Population projections

Population projections provide estimates of the size of the future population and are based on
assumptions about births, deaths and migration which are based on past trends.

Key messages

e The population of Wales is projected to increase by almost 9%, from around 3.1
million in 2011 to over 3.3 million in 2036

e The 65 to 84 and 85+ age groups are projected to have the largest increase by
2036, when an estimated 1 in 4 people in Wales will be aged 65 and over

e By 2036, it is estimated that the number of people aged 85 and over in Wales will
increase by nearly 145% (from around 75,000 in 2011 to over 184,000 in 2036),
with the largest increase seen in Flintshire (approximately 220%)

e It is estimated that there will be a small decline of just over 1% in the number of
people aged under 65 living in Wales by 2036, with the largest decrease seen in
Powys (approximately 17%)

e The largest projected population increase at the local authority level is in Cardiff
which is projected to increase by around a third, from an estimated 345,000 in 2011
to over 455,000 in 2036

e Three local authority areas are projected to have a decrease in the population in
2036 (Isle of Anglesey, Blaenau Gwent and Monmouthshire), with the largest decline
of nearly 7% seen in Blaenau Gwent (from around 70,000 in 2011 to 65,000 in
2036)

11
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Projection trends by age

Population projections by age group, percentage change since 2011, Wales, 2011 -
2036
Produced by Public Health Wales Observatory, using 2011 -based population projections (WG)
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Past trends and projections

Population estimates and projections*, count, Wales, 2011 to 2036
Produced by Public Health Wales Observatory, using MYE (ONS) & 2011 -based population projections (WG)
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Mortality

The main measure of mortality used in this profile is the European age-standardised rate
which accounts for differences in the population age structure between areas and over time.

Key messages

e All-cause mortality rates for under 75s and all ages have generally decreased in
Wales between 2004-06 and 2012-14

e Over the last 10 years in Wales, there has been a 16.5% decrease in all-cause
mortality rates in males aged under 75 and nearly 14% decrease in females aged
under 75

e In 2012-2014 the all-cause mortality rate for under 75s in Wales was 34% higher in
males than females

e There has been a 12.4% decrease in all-cause mortality rates for persons of all ages
between 2004-06 and 2012-14 in Wales (13.5% and 11.9% decrease for males and
females, respectively)

e In 2012-14, Blaenau Gwent had the highest all-cause mortality rate for persons
aged under 75 and all ages whilst Monmouthshire had the lowest all-cause mortality
rate for persons aged under 75 and all ages

e Wales had a higher all-cause mortality rate compared to England for both persons
aged under 75 (10.4%) and all ages (7%) in 2012-14

13
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All-cause mortality trends

All-cause mortality, European age-standardised rate per 100,000, persons,
under 75, Wales, 2004-06 to 2012-14

Produced by Public Health Wales Observatory, using PHM & MYE (ONS)
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All-cause mortality, European age-standardised
rate per 100,000, average annual count and
crude rate, persons, under 75, Wales, 2004-06

to 2012-14

A;'.?Jﬂgf Crude  paqR (95% CI)

count rate

2004-06 11,068 407 444 (439 to 449)
2005-07 11,021 403 436 (432 to 441)
2006-08 10,971 398 428 (424 to 433)
2007-09 10,931 395 420 (416 to 425)
2008-10 10,714 385 406 (402 to 411)
2009-11 10,538 378 395 (391 to 399)
2010-12 10,440 373 387 (382 to 391)
2011-13 10,481 374 383 (379 to 387)
2012-14 10,448 372 376 (372 to 381)

Produced by Public Health Wales Observatory, using PHM
& MYE (ONS)

EASR = European age-standardised rate

CI = confidence interval
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All-cause mortality, European age-standardised rate per 100,000, persons, all
ages, Wales, 2004-06 to 2012-14

Produced by Public Health Wales Observatory, using PHM & MYE (ONS)
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All-cause mortality, European age-standardised
rate per 100,000, average annual count and
crude rate, persons, all ages, Wales, 2004-06 to
2012-14

Average
annual
count

2004-06 31,854 1,072 1,189 (1,181 to 1,196)
2005-07 31,797 1,064 1,170 (1,163 to 1,178)
2006-08 31,765 1,057 1,153 (1,146 to 1,161)
2007-09 31,739 1,050 1,136 (1,128 to 1,143)
2008-10 31,422 1,034 1,107 (1,100 to 1,114)
2009-11 30,875 1,012 1,068 (1,062 to 1,075)
2010-12 31,041 1,014 1,055 (1,048 to 1,062)
2011-13 31,354 1,020 1,049 (1,042 to 1,055)
2012-14 31,693 1,028 1,042 (1,036 to 1,049)

Crude

0,
te EASR (95% CI)

Produced by Public Health Wales Observatory, using PHM
& MYE (ONS)

EASR = European age-standardised rate

CI = confidence interval
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4.3 All-cause mortality 2012-14

Under 75

All-cause mortality, European age-standardised rate per 100,000,
persons, under 75, Wales local authorities and health boards, 2012-14

Produced by Public Health Wales Observatory, using PHM & MYE (ONS)
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All ages

All-cause mortality, European age-standardised rate per 100,000,
persons, all ages, Wales local authorities and health boards, 2012-14

Produced by Public Health Wales Observatory, using PHM & MYE (ONS)
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4.4 All-cause mortality by Middle Super Output Area

Under 75

All-cause mortality, persons, under 75, Wales, 2012-2014
MSOA, European age-standardised rate per 100,000

657.3to 782.1[6]
532.4 to <657.3 [28]
407.5 to <532.4 [135]
282.6 to <407.5 [173]
157.7 to <282.6 [68]

OSSN

L

i

Local authority boundary

Produced by Public Health Wales Observatory, using PHM & MYE (ONS)
© Crown Copyright and database right 2016, Ordnance Survey 100044810
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General fertility rate

The general fertility rate is the number of live births per 1,000 females aged 15-44.

Key messages

e There were just over 33,500 live births in Wales in 2014

e Over the past 10 years, the fertility rate in Wales has shown little variation with a
small increase seen between 2005 and 2014 (56 and 59 live births per 1,000
females aged 15-44, respectively)

e In 2014, the highest fertility rate was in Denbighshire and the lowest in Ceredigion
(72 and 44 live births per 1,000 females aged 15-44, respectively)

e The presence of a large student population within a local authority tends to reduce
the fertility rate in that area, as students in higher education tend to have below
average fertility

e Denbighshire had the largest increase in fertility rate, from 59 per 1,000 females
aged 15-44 in 2005 to 72 per 1,000 females aged 15-44 in 2014

¢ Gwynedd, Rhondda Cynon Taf and Torfaen local authorities showed a small decrease
in fertility rate between 2005 and 2014

19
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General fertility rate trends

General fertility rate (GFR)*, Wales, 2005-2014
Produced by Public Health Wales Observatory, using PHB & MYE (ONS)
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*GFR is the number of live births per 1,000 females aged 15-44

General fertility rate (GFR)*, Wales,

2005-2014
Number
of live GFR* (95% CI)
births

2005 32,590 56 (55 to 57)
2006 33,623 57 (57 to 58)
2007 34,392 59 (58 to 59)
2008 35,644 61 (60 to 61)
2009 34,938 60 (59 to 60)
2010 35,945 62 (61 to 62)
2011 35,604 61 (61 to 62)
2012 35,238 61 (61 to 62)
2013 33,742 59 (58 to 60)
2014 33,541 59 (58 to 60)

Produced by Public Health Wales
Observatory, using PHB & MYE (ONS)

*GFR is the number of live births per 1,000
females aged 15-44

CI=Confidence Interval
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5.3 General fertility rate 2014

General fertility rate (GFR) *, Wales, health boards and local

authorites, 2014

Produced by Public Health Wales Observatory, using PHB & MYE (ONS)
H 95% confidence interval Wales = 59
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*GFR is the number of live births per 1,000 females aged 15-44
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General fertility rate by Lower Super Output Area

General fertility rate, Wales, 2014
LSOA, live births per 1,000 females aged 15-44

B 121.8to 151.5[1]
B 92.2 to <121.8[48]
[ 62.5 to<92.2[770]
[] 32.8 to<62.5[1021]
[] 3.2 to<32.8[69]
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|:| Local authority boundary

Produced by Public Health Wales Observatory, using PHB & MYE (ONS)
© Crown Copyright and database right 2016, Ordnance Survey 100044810
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